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About CHIAS IV 

CHIAS IV is an improved version of CHIAS (Fukui, 1986; Fukui and Mukai, 1988), which was developed 
to allow chromosome identification and facilitate quantitative chromosome mapping. The CHIAS IV upgrade was 
built on CHIAS II (Nakayama and Fukui, 1997) and CHIAS III (Kato and Fukui, 1998). The functionality of CHIAS 
has been improved by the addition of pseudocolor processing, an automatic process for sorting chromosomes, 
and a utility to measure the chromosome lengths and arm ratios. All procedures—from the input of the 
chromosome images to the drawing of the chromosome map—are automated in this version. 

License of the CHIAS IV programs 

When the data is published using these programs, should use the following quote in the materials and 
methods section "... analysis performed by the CHIAS IV system using the programs written by Seiji KATO, 
Nobuko OHMIDO, and Kiichi FUKUI" The word CHIAS or CHIAS IV must be appear in either the abstract and/or 
the keyword index. 
You may not: 1) sublicense, rent, lease of the programs. 2) assign of the programs. 

About ImageJ 

ImageJ is a public domain Java image processing program inspired by NIH Image for the Macintosh. It 

runs, either as an online applet or as a downloadable application, on any computer with a Java 1.4 or later virtual 

machine. Downloadable distributions are available for Windows, Mac OS, Mac OS X and Linux. 

Here are three possible ways to reference ImageJ: 

1. Rasband, W.S., ImageJ, U. S. National Institutes of Health, Bethesda, Maryland, USA, 

https://imagej.nih.gov/ij/, 1997-2016. 

2. Schneider, C.A., Rasband, W.S., Eliceiri, K.W. "NIH Image to ImageJ: 25 years of image analysis". Nature 

Methods 9, 671-675, 2012.  

3. Abramoff, M.D., Magalhaes, P.J., Ram, S.J. "Image Processing with ImageJ". Biophotonics International, 

volume 11, issue 7, pp. 36-42, 2004. 

 

System requirement 

CHIAS IV is based on the public-domain image-processing software ImageJ, which was developed by 
the National Institutes of Health (NIH; Bethesda, MD, USA) by using the Java programming language (Abramhoff 
et al., 2004). Java for Mac OSX (version 1.60.17, 32-bit) was used as the development language. The CHIAS IV 
program source file was compiled using the Java compiler associated with ImageJ. 
CHIAS IV runs on personal computers employing Windows XP and Mac OSX operating systems. ImageJ is the 
host application for CHIAS IV; for both operating systems, the software requires version 1.51 or later of ImageJ 
(http://rsb.info.nih.gov/ij/download.html) and Java version 1.4 or later (http://www.java.com/). 
 

Program file 

The CHIAS IV program file (CHIAS4_xxx.jar; "xxx" shows a version.) can be downloaded from the following site: 
http:// www2.kobe-u.ac.jp/~ohmido/cl/chias4/. 
 

  

https://rsb.info.nih.gov/nih-image/
https://rsb.info.nih.gov/ij/download.html
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Installation and start-up 

 
 

Installation of ImageJ 

Download ImageJ from ImageJ download site ( https://imagej.nih.gov/ij/download.html ). 
 
Cation: CHIAS4 1.2.3 is required ImageJ v 1.51 or later (ImageJ v1.52o was used to check the 

operation.). 
You can upgrade or downgrade of ImageJ at “Upgrade ImageJ” command in “Help” menu from Menu bar of 
ImageJ. 

 

Installation of CHIAS IV 

CHIAS IV can be installed by clicking on the "Install ..." button in the ImageJ "Plugins" menu.  

Choose the CHIAS4_xxx.jar file (xxx denotes the version) from the dialog (This is also possible to copy 
the CHIAS4_xxx.jar file to the "plugins" folder in the "ImageJ" folder as in the previous manual).  

If you have an older version of CHIAS4 installed, please remove the file from the folder. 
 

 

Startup CHIAS IV 

After installation of the software, CHIAS IV can be started. Click the ImageJ icon. A menu of ImageJ is displayed. 
Choose “CHIAS IV Menu” in “CHIAS” of the Menu bar. The dialogue for entry of the image resolution is 
displayed. Input resolution of the image of a characteristic of the CCD camera. The value displayed in the menu 
is double of the input value so that it is enlarged an image in double at the time of the measurement. CHIAS IV 
menu window is displayed.
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DIALOG for enter of the initial setup is displayed   
 

 
 
 
 
 
 
Dialog window for enter of the initial setup is displayed 
Input follows. 
Setting Notes: Inputs the date, room, image entry device names, etc. You can omit it. 
Scale(pixels/µm): Input resolution of the image to the resolution of the camera. 
Magnification of the image resolution(x2): When you enlarge image to double at the time of measurement, 
add a check in check box "Magnification of the image resolution(x2)". There is a check in the default.  
(please add a check basically. This option is for operation tests.) 
Counterstain Slice: Choose slice of the counter stain from Red, Green, Blue. 
(The initial setup is Blue.) 
Click the OK button after setting in an article, and CHIAS Step1 menu window is displayed. 

 
 
"Scale" is displayed by the upper part of the panel window. 
When "x2" is displayed if you choose magnification in an initial setup and does not 
magnify it, "x1" is displayed. 
The text color of "SetDensity" is displayed with a color of the counter stain which you 
chose in an initial setting. 
Signal1" and "Signal2" under "Set desnsity (Signal)" are displayed with the rest of color 
except the counter stain. 
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Step1 - The measurement of the fluorescence profile 

1.1 Open Image 

An image is opened as an RGB stack. 
 

Click the Open button in CHIAS IV menu window. The color image is opened as three 
pieces of gray scale images namely RGB stack. Move a bar of the bottom of the 
window to counter stain slice (DAPI, right-side end). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. RGB stack image 

 

1.2 SetDensitySlice 

Chromosomal regions are extracted from the image after regional adjustment of the threshold． 

 

1. Choose counter stain slice of the opened 

RGB_stack image firstly. Confirm that Straight 

Line tool is chosen. Draw a line of the length 

that is almost width of the chromosome. 

2. Click a “SetDensity” button in CHIAS IV 

menu window. Input an appropriate value into 

Radius to the dialogue window which appeared.  

3. The dialog window is opened. Chose filter 

type.  
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①low pass filter (multiple) 

⑴ Choose counter stain slice of the opened RGB_stack image firstly. Confirm 
that Straight Line tool is chosen. Draw a line of the length that is almost 
width of the chromosome.  

⑵ Click a “SetDensity” button in CHIAS IV menu window. Choose “low pass 
filter (multiple)”.  

⑶ The dialog window is opened. Please confirm the number of the filter size. When a displayed number is not 
suitable, input a number again.  

⑷ Please wait until Message window appears (about 2 or 3 minutes). 

⑸ The image which subtracted local mean value is made as a stack consisting of six pieces of slice. The details 
of the stack are shown below. There are no lowpass filter image and images which subtracted a background 
using lowpass filter of 0.5, 0.75, 1.0, 1.25 and 1.5 times of the length of the drawn line. You can move the 
slice in the stack by shifting a bar of the lower part of the image to right and left.  
 

⑹ Threshold Window is displayed. Operate the bar of the bottom 

of two slider bars in “255 " (the right-side end). Adjust the bar of 

the upper part so that only chromosomal regions turn red. After 

adjustment, buttons such as “Apply” of the Threshold window 

must not be clicked.  

⑺ Click individual chromosomal region while pressing the Shift key till all chromosomal regions are chosen. It can 

be added the selection area at ROI Manager displayed automatically. You can store selected regions to 

displayed ROI manager. Chromosomes may be close together on this occasion. It is separable later. After 

setting, you must not click "Apply". Try six pieces of slice. Use the slice which you can extract most neatly. 

On this occasion, you can use "Add to Manager" button of the lower part of ROI Manager window displayed 
with a window of Threshold. 
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②low pass filter (single) 

⑴ Choose counter stain slice of the opened RGB_stack image firstly. Confirm that Straight Line tool is chosen. 

Draw a line of the length that is almost width of the chromosome. 

⑵ Click a “SetDensity” button in CHIAS IV menu window. Choose “low pass filter (single)”. 

⑶ The dialog window is opened. Please confirm the number of the filter size. When a displayed number is not 

suitable, input a number again. 

⑷ Threshold Window is displayed. Operate the bar of the bottom of two slider bars in “255 " (the right-side end). 

Adjust the bar of the upper part so that only chromosomal regions turn red. After adjustment, buttons such as 

“Apply” of the Threshold window must not be clicked. 

⑸ Click individual chromosomal region while pressing the Shift key till all chromosomal regions are chosen. It 

can be added the selection area at ROI Manager displayed automatically. You can store selected regions to 

displayed ROI manager. Chromosomes may be close together on this occasion. It is separable later. After 

setting, you must not click "Apply"． 

③Subtract Background(Built-in Command of ImageJ) 

⑴ Click a “SetDensity” button in CHIAS IV menu window. Choose “Subtract Backgroud)” 

⑵ The dialog window of Subtract Background is opened. Turn on the “Preview”. Input the number into rolling ball 

radius. 

⑶ Threshold Window is displayed. Operate the bar of the bottom of two slider bars in “255 " (the right-side end). 

Adjust the bar of the upper part so that only chromosomal regions turn red. After adjustment, buttons such as 

“Apply” of the Threshold window must not be clicked.  

⑷ Click individual chromosomal region while pressing the Shift key till all chromosomal regions are chosen. It 

can be added the selection area at ROI Manager displayed automatically. You can store selected regions to 

displayed ROI manager. Chromosomes may be close together on this occasion. It is separable later. After 

setting, you must not click "Apply".  

 

④No filter 

       Filter operations are omitted Filter operations are omitted. 
       The operations except the filter are the same as the above. 
 
Note) Actions to be taken when FISH signals protrude from chromosomal regions. 
Execute 1.4 “Signal Control” before 1.2 “Set DensitySlice”. 
Record signal areas to click the “Add” button of ROI Manager. 
Click individual chromosomal region while pressing the Shift key till all chromosomal regions are chosen. 
Click all ROI (signal areas and chromosomal regions) in ROI Manager with pushing the Shift key. All ROI are 
selected. Modified ROI is displayed. 
Shift to “1.3 Erase BackGround” 
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1.3 EraseBackGround 

 

Click the "EraseBackGround" button in CHIAS IV menu window. Background region of the 

counter stain slice is erased. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.4 Signal Control (option) 

Extraction of the signal regions.  
You can omit this operation. You cannot use this operation for reiterated sequences. 
 

1. Click “Signal1” of "SetDensity (Signal)" in the CHIAS menu window after selection in "Plate" image. 

2. Threshold Window is displayed. Operate the bar of the bottom of two slider bars in “255 " (the right-side end). 

Adjust the bar of the upper part so that only chromosomal regions turn red. After adjustment, buttons such as 

“Apply” of the Threshold window must not be clicked.  

3. Click individual Signal region while pressing the Shift key till all chromosomal regions are chosen. Record signal 

areas to click the “Add” button of ROI Manager. 

4. Click Deselect button of ROI Manager. Confirm that you choose no ROI, and click Save button of ROI Manager. 

All ROI is saved as one zip format file. 

5. Choose all ROIs in the list of ROI Manager. Click "Combine" from "More>>" of ROI Manager. 

6. Click “EraseBG” of “Signal Control” of “CHIAS menu” window. 

7. Result window is displayed, but close this without saving it. 

8. Click “Signal 2” of "SetDensity (Signal)" in the CHIAS menu window after selection in "Plate" image. Repeat the 

same operation. 

9. Save "Plate" image at TIFF format from "Save As" of the “File” menu of ImageJ. 
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1.5 Draw line 

Separation of an overlapping chromosomes. 

1. Open the "Plate" image which you saved if "Plate" image is closed. 

2. Move the bar of the lower window to the right end. 

3. Click ”Draw line” of the ”CHIAS menu” window. Draw a line on overlapping chromosomes. 

4. Click ”Draw line” of the ”CHIAS menu” window. Chromosomes are separated. 

5. Save the image in a TIFF format. Change the file name. 
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1.6 Edit ID 

Chromosome numbers are automatically added to all chromosomes by area order. 
      

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

1. Click "Open" button. Choose the "Plate" image which separated a chromosomal regions. 

When you have already opened this image, you can omit this work. 

2. Click "Edit ID" button of the CHIAS Step1 menu. 

3. Four buttons of “Create Auto ID”, “Save with ROI”  

“Sort” “Enhanced LUT” are made by the lower part of the Plate window. 

4. Move a bar of the lower part of the window in the right edge (counter stain). 

5. Click “Create Auto ID” of the lower part of the window. 

6. ROIs of the chromosomal regions are displayed by ROI Manager, and ROIs are displayed in image.  

7. Change the name of ROIs in ROI Manager made by Add ID. It becomes easy to confirm ROI in image by using 

the Show All command in ROI Manager. The ROI name is enabled by clicking Rename button on the right 

side of the ROI Manager window. It is sorted in order of 0-9, A - Z. Therefore, you should make 01a, 01b, 02a 

when chromosome number is over two columns. You can specify order in the automatic sort like "02a_auto03". 

And you can enter as a memo by an ROI name like "01a_signalFITC". 

8. It enables sorting of ROI in alphabetical order to click "Sort" button. ("sort" button appears in a submenu by 

clicking "more" button in "ROI Manager".) 

9. A image including the ROI information is saved with "Save with ROI" button of the lower part of the image 

window (the suffix becomes .zip). 

 

 

 

 

 

 

  

Tips ： About the region setting of the 

chromosome which overlapped 

1. Duplicate "plate" window by "Duplicate" 
command of the Image menu of ImageJ.  

2. Cut overlap region with line tool. And make 
ROI of the chromosome with wand tool. 

3. Add ROI which you made to ROI manager. 
4. Close duplicated the image window. 
5. Operate another one chromosome 

repeatedly in the same way. 
6. Choose automatic made ROI where two 

chromosomes overlapped. 
7. Click "delete" button of ROI manager. 
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1.7 Sort 

Sort chromosomes． 

 
 

1. Click the “Sort” button under the image window. 

  Choose slice of the counter stain. 

You cannot label the chromosomal regions with other slice. 

2. According to DIALOG, input chromosome number (including the number of the satellites separating). 

3. The dialog window is opened. Please select the layout style.  

 

1. Ploidy layout  

The dialog window is opened.  Please input the number of rows to locate and polyploidy. 

 

Sort window and labelled Plate window are displayed. 

 

Before sorting  

 

Haploid (one row) 

 

Diploid (one row)  

 

Tetraploid (2 rows)  
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2. Standard montage  

Message window is displayed, and input the number that is suitable for Columns, Rows. 

 

 

 

 

 

Sort window and labelled Plate window are displayed. 

Chromosomes are sorted in a region of interest (ROI) according to their name order. Then, the chromosomal 
orientations are corrected for a vertical alignment. The image is enlarged by a factor of 2 to prevent image-
quality deterioration during the rotation process. 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

4. Check the direction of rotation of individual chromosomes before sorting. Use the bottom button of the 

panel (This function is currently in beta phase.). 

1. Pre Rotate 

 

 

Check the direction of rotation of individual chromosomes before sorting. Use the bottom button of 

the panel. 

 

After selecting one ROI in the ROI manager, click the "Pre Rotate" button to rotate the selected ROI 

and display the rotated image of the selected ROI in a separate window. You can check the direction of 

the chromosome arms before sorting the chromosomes. 
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 Use of Rre Rotate               Add Rotate to add tags, and execute Rre Rotate. 

2. Add a tag (_rotate) to the ROI name to correct the direction of rotation. After selecting a ROI in the 

ROI manager, click the "ADD Rotate" button to add "_rotate" to the end of the ROI name. If "_rotate" 

is added to the ROI name during Pre Rotate and Sort, the chromosomes will be rotated an 

additional 180°. In other words, the direction of the chromosomes will be reversed. Use this option 

when the short arm is on the bottom. Check the direction of the chromosomes in Pre Rotate, and if 

they are opposite, use Add Rotate to sort the chromosomes in the correct direction.回転の向きを補正 

3. Rename the ROI 

3. rename the ROI. 

4. "You can use this function to delete the tag (_rotate) added by "ADD Rotate". 
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1.8 Rotate the chromosome 

The top (short arm) and bottom (long arm) of the chromosome are turned upside down. 
Select a created Sort_AREA image, and move a bar of the window bottom to counter stain slice. Click a “R180” 
icon in the tool bar. Click the left outside of the chromosome which should turn in the image window. The top and 
bottom of the chromosome turns over. 
 
 
 
 
 

1.9 Detect centromere 

The chromosomal arms are separated at the centromeric region. 
 
1. Select an image, and move a bar of the window bottom in counter stain slice. 
2. Make pseudo colorization in ChangeLUT.  
3. Click a "Select arm" button in the CHIAS IV menu window.  

4. Surround chromosomal short arm part after the polygon icon  of the menu bar was chosen.  
5. Click a "Cut" button (the right side of" Select Arm") in the CHIAS IV menu window. Short arm moves, and it 

is separated.  
6. Movement of the short arm is usually two pixels to the upper for the vertical, but pixel value and a direction 

of the movement can be changed when a bent chromosome is treated.  
7. The image which separated short arm of all chromosomes can be saved by a File menu of ImageJ.  
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1.10 The measurement of the Condensation pattern (CP) or the Fluorescence Pattern 
(FP) 

A line is drawn along the midrib of the chromatid, and the CP or the FP on the line is measured. 
1. Select “Sort” window.  
2. Click a "CPpanel" button in the CHIAS IV menu window.  

Operation buttons are made at the lower part of the “Sort” window. 

 

The button which is displayed at the lower part of the panel 

(The following operation is executed by Click.) 

Draw midlib line: Segmented line tool is chosen. 

Aｄｄ Line: Line ROI is added to ROI Manager. 

CP：CP or FP is measured. 

Save with Line: The image and all Line ROIs are saved to one file by zip format. 

Enhanced LUT: The image is changed to hyper stack, and LUT is improved. 

Zoom in, Zoom out:画像がズームされる。 

Scroll: The scrolling tool is chosen. 

Reset result: Results of measurements are reset. ROI Manager is not reset. 

    But ROI is reset when you opened the panel window again. 

We encourage it to save image and ROIs before closing a window.  

 

3. After the “draw midrib line” button of the lower part of the “Sort” window was chosen, draw a line so that a 

chromosomal midrib line passes signals. Signal slice can be moved a bar of the image window bottom. 

4. After drawn a line, click the “add line” button. The segmented line is added to the ROI manager. 

5. Change the name by rename command of ROI Manager after addition in segmented line. 

6. Please execute this operation for all lines. 

7. Click "save with line" of the lower part of the Window panel after addition in all lines. All lines are saved with the 

chromosome image. The save is possible in the middle of operations. 

8. Choose one line roi in the ROI manager, and click the "CP" button of the lower part of Image window. 

The Condensation pattern is measured. 

The line ROI name is displayed next to No. of “Result table” Window, and measurement parameter is displayed 

continuously.  

The line ROI chosen in "ROI Manager" moves to the very last of the list and is given a measurement number 

in results table next to the line ROI name. chromosome length and an arm ratio are added to an ROI name 

continuously. 

It is the latest result of a measurement the last of the list of ROI Manager. 

 

9. CP or FP is measured. Save "Colorgram" in "Save As-Tiff ... " from a File menu of ImageJ. Save it with the file 

name that nuclear plate name, the chromosome number can identify to use it at Step2 
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(example :colorgram01-chr1-1). 

 

10. You can open the image and ROI which you saved in "Save with Line" with "Open with Line" button of the 

"Step1 panel "menu. 

 

 

 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save this window. 
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Step2 Create standard profile 

Click "Show Idiogram tools" of the CHIAS Step1 menu. The Idiogram tool bar  is displayed. 
Click "Show Rotate tools". The tool bar used in Step1 is displayed again. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2.1 Average of the profile (the AVG tool) 

The profile data of measured homologous chromosomes are averaged. 
 
 
 
 
 
 
 

1. Click a “Close All” icon in the menu window of ImageJ. All images are 

closed.  

2. Select an Open command a File menu of ImageJ. (warning; It is not the 

Open button in the CHIAS menu). The dialogue that multiple file choice 

is possible is displayed. Select multiple Colorgram files while pressing 

Control key (win) or the Cmd key (Mac). Multiple Colorgram is opened.  

3. Click a “2 AVG” icon.  The averaged profile data (Colorgram) is 

displayed.  

4. Save averaged data with “Save As-Tiff ...” from a File menu of ImageJ. (e. g. AVG_stackAve04.tif).  

5. Repeat the same operations at Colorgram of other chromosomes. 
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2.2 Align all Grayrgrams of chromosomes (the Align tool) 

All measured chromosomal 
Colorgrams are aligned to 
one image based on 
centromere regions 
 
 

 
 
 

 

1. Click a “Close All” icon in the menu window of ImageJ. All images are 

closed.  

2. Select an Open command a File menu of ImageJ. The dialogue that 

multiple file choice is possible is displayed. Select multiple Colorgram 

files while pressing Control key (win) or the Cmd key (Mac). Colorgram 

is displayed by order of the file selection. Multiple Colorgram is opened. 

3. Click a “2 Align” icon . A image with aligned graygrams is created. 
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Step3 Create an Idiogram  

3.1 Create graygram 

The averaged graygram of the counterstain layer obtained in Step 2 is created by using the Otsu method for 
automatic thresholding.  
 

Select a Graygram window created in Step2. Move to slice of the counter stain. Click a ”3 thres” icon  of the 

tool bar. A part of Graygram is displayed in red automatically by Otsu method. When a revision is necessary, choose 

“Image” menu - “Adjust” – “Threshold” of ImageJ. You can set up a chromosomal condensation region (a gray part) 

by manual operation.  

 

3.2 Fix condensed regions 

The first threshold in the gray level is determined. The gray areas (i.e., condensed regions within a chromosome) 
of the chromosomes are identified.  

After setting, click "3 FixG" icon of the tool bar. It is changed the region of a dark staining part of the graygram 

to a binary automatically. another methods and the setting by the manual operation are possible, too.  

3.3 Fix highly condensed region 

The most condensed area is determined. The black areas of the chromosomes are identified.  

After setting, click a ”3 FixB” icon of the tool bar. Idiogram is created.  

 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

                                               
A note: These idiograms analyzed only the chromosomes which a signal ware detected.  
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Visibility improvement option 

Additional functions of CHIAS4 for printing and presentation. You can use this option from an image analysis 
function of CHIAS4 independently. 

4.1 Adaptation of the LUT for luminance extension 

This function displays images by “Look UpTable” that have been improved to assist the recognition of the 
brightness of DAPI and other counter-stein information. LUT is changed only to counter stain channel of each 
RGB channel. A format called "Hyper Stack" of ImageJ is used to compose each channel of the RGB with using 
LUT. 
 

1. Open the image file of an RGB color format or the RGB stack format from "Open" of the "File" menu of 

ImageJ.  

2. Click "Enhanced LUT" of Brightness Enhanced LUT "of "Visiblitiy improvement" of the "CHIAS" menu. 

   

3. The Dialog window for confirmation of the counter stain is displayed. The color of Preferences is displayed. 

You can choose "ResetLUT" which returns LUT to RGB in addition to "Red" and "Green" and "Blue".  

Caution: The value set in this DIALOG is not reflected by "CHIAS4 preferences". 

4. A channel of the counter stain which LUT was changed to is displayed.  

You can choose "Color", "Composite" and "Grayscale" from the select menu of the "Channels" window. 
"Color" is chosen an LUT change just after that, and channel of the counter stain is displayed. When you 
choose "Composite", a channel chosen with a check box is displayed. The image that a RGB channel 
was composed when you check all channels is displayed. When you choose "Grayscale", a channel 

chosen like an RGB stack is displayed as a gray scale.

 
 
Other commands "StackTo hyperstack": A RGB stack is changed to a hyper stack. 

"HyperStack toStack"：A hyper stack is changed to an RGB stack. 

"ChannelsTool "：A channels tool window is displayed.  
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4.2 Addition of the scale bar 

Using the resolution information of Preferences to use in CHIAS4v1.2, a function to display a scale bar on 
chromosome image was added. 
 
1. Click "Add scale bar x1" ( or x2) of "Add scale bar "of "Visiblitiy improvement" of the "CHIAS" menu. The 

original image resolution (before extended in the CHIAS4 operation, e.g., image before the sort) choose "x1". 
The image resolution after the magnification ( sorted image and idiogram)  choose "x2". 

2. Dialog window for scale bar display is displayed. 5m in width, height (pixel) and others are displayed. Put a 
check in "Overlay", and then click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When ROI has been already set, "width" consists 
with the width of ROI. 

Input a suitable number in displayed "width". The adjustment of the display position of the scale bar is possible in 
Location. You make ROI beforehand to display a scale bar in any position. You can display a scale bar in the 
starting point on the left of ROI by executing "Add scale bar x1"(or x2) command. 
 
Other commands CHIAS4 Preferences: Open of the input window of Preferences 
   Set scale only this image 
   Hide ScaleBar 
   Show ScaleBar 

4.3 Save of the image 

1. Save As Jpeg (the format that is available with other application) 

Click "Save As Jpeg" of "Visibility improvement “ of the "CHIAS" menu. 

 

2. Save as the LUT enlargement hyper stack format with scale bar 

(the format that is available only in ImageJ) 

Click "Save with ScaleBar" of "Visibility improvement" of the "CHIAS" menu. 
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